How to Setup Your
Exhibitor Emails

Easy as 1-2-3

For Assistance and Technical Support
Convention Data Services
xpressleadpro@cdsreg.com
1-800-746-9734
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Welcomel!

XePress Exhibitor Emails is a FREE program that wraps your unique message in the event brand and allows you to
invite your prospects and clients to the event with a special offer from show management. This manual walks
you through the entire process and shows how to retrieve results from your campaigns.

Getting Started ......cccoccvvveeeecieeeeeeee e,
Easy as 1-2-3 .t
Step 1 — Company Info .....cccoveeevciieeiciiienn,
Step 2 —Email ListS ..cccvvveeeeiieeecieee e,
Step 3 —Campaigns ....ooeeevireeeeeeeeeiireeeeen,
Campaign StatsS.....ccvvvevniiiiiiieieee e,

Getting Started

1. Login to the Event Exhibitor Registration Site

2. Select your company name from the drop
down menu

3. Enter your company password

4. Click “Continue”

5. Select the “Exhibitor Emails” tab

6. Click the green “GET STARTED” button
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12 DAYS UNTIL THE 2011 SHOW BEGINS

2011 Exhibitor Registration 4

Important Message - Please READ:
+ The Primary Contact is not automatically registered to receive a badge.
* You must register as a booth personnel to receive a badge. ’
* Data wil appear exactly as entered. Use Title Case. Do not key data using all CAPITAL letters o all lower case letters.

Please select your company name from the drop-down list and enter your password.
(Your password is located in your 2011 Show Confirmation Letter)
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Fields in bold are required.

Company Name :

Company Password :

| [Fossistait. | anstecturer ope. | Lesd selual ] crrior cmats | andes it ] Press e ] - viem tovietons J

XePress Exhibitor Emails

My Registered Guests: No one has registered using your unique Priority Code - CDSTEST.

Want to Close More Deals?
Use FREE Exhibitor Emails to

promote your company and invite
your prospects to the event.

Enter Information
Easy As (&) Upload Lists
Send Invitations

Increase Booth Traffic
A Email your unique message wrapped in the event

brand and invite your prospects and ciients to the
event with a special offer from show management.

Track Results
PN 1t's easy to track how well your campaigns are working
11 with complete metrics and data about which prospects

have responded, and those who haven't
Pres it e web site where l

cy are protected

you
and respected 100%.
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Easy As 1-2-3

Setting up your complimentary email
campaigns is an easy three step process.
Enter your company information, upload
your email lists and create your email
campaigns.

1. Click the Number 1 or the “Next”
button on the Exhibitor Emails
launch page to get started.

1 - Company Info

® weicome to the Exhibitor Emails system, which will allow you to send 20 personalized email campaigns to your existing
and prospective customers. It takes only a few minutes to setup and is completely free.

Click here to preview the email templates.

Email Wizard:

Company Info Email Lists

Overview:

Email Campaigns/Stats

Your booth number and company name
will prefill in the form fields.

1. Upload your company logo graphic

Logos can be gif, jpg, or png files.
Oversized images will resize
automatically to the program’s
maximum width or height

2. Enter information in the remaining
fields for your company and contact
information

3. Click the “Save & Continue” button

Required fields are indicated with a red
asterisk (*).
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Company Info:
Company Info:

If your bosth number is blank, Show Management will be updating the booth number shortly. Please be patient.

Booth Number: 10

*Company Name: Convention Data Services

Company Logo: Uploaded Image: You can upload any .gif, -jpg, .jpeg, or .png image that is smaller than 2 M8, The optimal
dimensions are 268x72 pixels, RGE files only (no CMYK).
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Clear Image

Website URL: [http://www.conventiondata services.com

Company Contact Info:

This company contact information will be included in your email blasts.

*First Name: e
Job Title: Exhibitor Services Acct Mgr

Phone Number: (Jeoo  )[7ae  -[s73¢  x|i112
[ International:

Email: sbarove@cdsreg.com
Save & Continue » - 3
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2 — Email Lists

Saving your company information or clicking the Step 2 graphic at the top of any page opens the Email Lists

screen. You can add multiple email lists, each list can have any number of emails. Emails can be sent to more

than one list in a single campaign.

A.

Click the “Add Email List” to add a
new list

OR

Click the “View/Edit” link in
front of an existing list name to
make changes

Click the “Save & Continue”
button after your done editing
email lists

Clicking “Add Email List”

1.

2.

Enter a name for the list

Click “Continue to Edit Emails”

3 Ways to Add New Lists

Cut and paste emails
(preferred method)
Use an Excel template
Type emails

Cut and Paste Emails

1. Paste emails separated by
commas or semicolons, or in
columns from a spreadsheet
into the text field

2. Click the “Add Now” button
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Email Lists:

n Add a new email list or edit your existing lists.
. 4 A
Lists:
List Name

View/Edit Aii's Test List 'B

view/Edit Kens Prospect List

View/Edit Mike Q Testing
View/Edit Steve's List

-c

Email Lists:

List 10 Email Addresses:

o Ways to Import Email Addresses:

1. Copy & Paste - You can paste email addresses from MS Excel, MS Word or any other text editor
2. CSV File Import - Import via a spreadsheet
3. Manually - Click the "New Email Address" button below

Email Addresses. New Email Address

List 10 - Import Email Addresses via Copy & Paste:

“Emails: (chars left: 1499931)

fonarthrop@email.coml

_2
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Use an Excel Template

1.

Click “Download emails_template.xls” to download the template spreadsheet

Enter the list information into
the spreadsheet fields

Browse for the file and upload it

Click the “Save Now” button

Type Email Addresses

1.

Click the “New Email Address”
button

Enter the email, contact’s name
and company

Click “Save” to continue
entering emails

Click “Save & Continue” to
return to the Email Lists main
screen

Clicking “View/Edit”

In the edit view the emails in the

selected list are show with edit, copy
and delete links for each address.

A.

New emails can be added to
any list by clicking the “Add
Email” button above the grid.

Export the list by clicking the
“Download emails.xls” link.
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Save & Continue » - 4

List 10 - Import Email Addresses via CSV File:

R F
+ Open MS Excel and select File->Operfand open emails_template.xls.

= Fill in the spreadsheet and then click File->Save As. Enter any file name and then save this file as a3 CSV (Comma delimited) (* usv) file. NOTE: Every
ed.

ow must have at least an email address. All other columns, including the headings of these other columns, can be omitt:

 Click the Browse button below, select your .csv file, and then click Upload Now.

* Note 1: The 1st row of entries in your spi must pond with the appropi field names (see the template).

+ Note 2: Please be patient after you dlick Upload Now as the processing_may take up to 30 seconds to complete.

“Uplead File: [ Bowse.. - 3

_4

List 10 Email Addresses:

o Ways to Import Email Addresses:

1. Copy & Paste - You can paste email addresses from MS Excel, MS Word or any other text editor
2. CSV File Import - Import via a spreadsheet
3. Manually - Click the "New Email Address" button below

“Email Addresses: [ ey Email Address | h
No Email Addresses have betn entered. Please click the "New Email Address” button abave to add a New Email Address.

List 10 Email Addresses:

“Email Addresses: "
“Email ismith@email.com 2

FirstName: [ohn
LastName: [gmich
Company:  [Biltmore Hastings LLC|

(e < 3

it Addresees: i B - A

Email Addresses:

Entries: 6 Rows per Page: (20 ||
Email First Name Last Name Company Added On

Edit Copy Delete flatstanley@gmail.com  Flat Stanley 3K Publishing Feb 24, 2011 3:12 PM
Edit Copy Delete info@edsreg.com Mikce Long ABC Company Feb 24, 2011 3:12 PM
Edit Copy Delste ken@cdsreg.com Ken Ferreira Convention Data Services Feb 24, 2011 3:12 FM
Edit Copy Delste mkolter@cdsreg.com Mara Kolter cos Feb 24, 2011 3:12 PM
Edit Copy Delete Sales@cdsreg.com David Lawton OYC Coaching Feb 24, 2011 3:12 PM
Edit Copy Delete xpressleads@cdsreg.com Steve Barove RR Monthly Magazine Feb 24, 2011 3:12 PM

Entries: 6

Save & Continue »

n Download emails.xls
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3 — Email Campaigns/Stats

Step 3 of the process allows you to create, schedule and track your email campaigns. Each exhibitor is allowed

three email campaigns.

There is a grid listing the email campaigns that you have created. Campaigns that have been sent can be copied

and results displayed. New campaigns can be edited, copied and deleted—up to the time that the campaign is

sent.

A. Click the “New Campaign” button
to add a new email campaign

OR

B. Click the “Stats” link for a
campaign to see results

OR

C. Click “Edit,” “Copy,” or “Delete” to
change an unsent campaign

Clicking “New Campaign”

1. Add email lists to the campaign by
highlighting a list in the first field on
the left and clicking the “Add”
button

2. Enter your company and
promotional information in the
fields provided

3. Upload a graphic as a gif, jpg or png
file

4. Enter a date and time for the
campaign to be sent
NOTE: If date is unknown, select a
future date and adjust later.

5. Select one of the templates for

your email campaign from the drop
down menu
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Email Campaigns:

n Add a new email campaign, edit a pending campaign or review a campaign that has already been sent.

AT o o

Campaigns:

Sevea Contnie -

Product Name Send Email Email  New Already Not

on Stats i i i
Email  XPress LeadApp Feb32, 2011  Stats B 2
Broof 1:30 PM
Email  XPress LeadApp Feb 28, 2011 Stats 0 0 12
Proof 9:00 AM
Email  XsPress ul1, 2011 WA /A /A N/A
Frocf  Exhibitor Emails  3:00 AM

Entries: 7

M Registrants Using Your VIPCode: 2

Note: The "Already Registered” and "Not Registered” values are estimates as a recipient can receive an email at one of the receipient’s email addresses and
use another email address when the recipient actually registers.

Email Campaigns:

n Add a new email campaign, edit a pending campaign or review a campaign that has already been sent.

Campaigns: Create your email bla

*Send to Lists:

1 e

From Email:
*Email Subject:

Custom Gresting:

2 mmp

Product Name:

Product Description:

Product Website URL:

Product Image:

4 *Send Email On:

5 *Email Template:

st by entering the content into the form fields below.

Lists:

Annas test list 2
candi

Geoff's List
Kens Prospect List
List 10 2

sbarove@cdsreg.com

[Want to close more deals?

Send to Lists:
- Add » Anna's Test List

You can add additional Email Lists on Step
2.

You can hold Ctrl to select muliple lists
simulatencusly.

(chars left: 433)

FREE XePress Exhibitor Emails R
XePress Exhibitor Emails is a FREE program that wraps your
unique message in the event brand and allows you to invite
your prospects and clients to the event with a special offer

from show management.

[Access to this service is provided as part of your exhibitor
registration process.

XePress Exhibitor Emails

(chars left: 322)

[XePress Exhibitor Emails is @ secure a
web site where your lists and your
prospect's privacy are protected
and respected 100%.

NO GNE other than you has access E
to your lists. They are used for your

campaigns only.

xsPress Exhibitor Emails is CAN-SPAM Act compliant. People |
receive at most one email per day. Prospects can opt-out of .

[http://www.xpressleadpro.com

You can upload any .gif, -jpg, .jpeg, or .png image
that is smaller than 2 MB. The optimal dimensions are

mress” Lea dS 288x216 pixels. RGB files only (no CMYK).

Clear Image

wl [=]/[1 [=]/[2011]5] ]
Columns [=]

Uploaded Image:

5 =] :[00 [=][AM[z] E2stern Stendard Time
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6. Review your template in the Email Proview:
preview window
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MasterMedical 2011,
7. Click the “Save” button to save '
. REGISTER NOW for a FREE Exhibits Only Pass*, courtesy of Convention Data Services
H H Whatever your medium, this is your canvas. The seamless
your information and template CONVENTION | hearatom o vaktogs o s ly oot
. form and created new platforms ripe with oppertunity. Come to
h . 2 NATA SERVICES the NAB Shouw this year to se the |atest trends in mabile, 3-D,
cholice g online video, pro audio and more, identify integrated solutions
and exchange strategies at the global level. From creation to
Convention Data Services would | onsumption, this is the place where possibiities become realities
conventio e ~and where you'l meet the innovators who can bring your next
like to invite you to come join us maﬂemece e
. . at NAB Show. B ’
The Spell Checker will openin a ek e to reaieter. More han Sz brosdeastng, the KAB Show = the workd's sroest
gathering of leading media, entertainment and communications

FREE XsPress Exhibitor Emails professionals who share a passion for bringing content to life on

new ta b XsPress Exhibitor Emails is a FREE program | any platform — even if they have to invent it
that wraps your unique message in the Click here to register.
event brand and allows you to invite your
prospects and clients to the event with a
;pac\al offer from show management. XePress Exhibitor Emails

coess to this service is provided as part of

your exhibitor registration process. w
XePress | cadls
Services Acct Mar

menti@cdsreg.com .

34 x1112 X¥ePress Exhibitor Emails is a secure

web site where your lists and your

prospect’s privacy are protected

and respected 100%.

NO ONE other than you has access

are used for your

Website

onventiondataservices.com

ttp:

4 $20 processing fee applies to all

registrations received after April 7, 2011 to your lists. Tl
campaigns
XePress Exhibitor Emails is CAN

Act compliant. People
receive at most one email per day. Prospects can opt-out of
receiving further emails from the system.

lationship vith Convention Data Servic
mails about NAB Shovi

ved this email bacause you have 2
unsul

be to stop rec

on of Broadcastars
hington, DC 20036

national
1771 N Street N

Powerad by GoExpo and CDS.

7 D =

Mot in dictionary:

8. Correct any spelling mistakes
and click the “Close” button

Change to:

[ Ignore Ignore All ]

J [
9. Click the browser tab to return [ Repace | [ Repaceal |
to your campaigns 8 ‘

10. Click the “Email Proof” link next compaions:
tO your Campalgn name tO Send Product Name g«:nd Email g'r:zl New Already Not
yourself and others a copy of S| gmal [xeremissitgn [rebzaont (g 2 °

the campaign 10 ‘ g [ REh eEn (€ ° =

Edit Copv Delete Email  XePress Jul1,2011  N/A N/A N/A /A
Broof  Exhibitor Emails  9:00 AM

Entries: 7

11. Click the “Save and Continue”
button to complete the
campaign setup

11

M o Registrants Using Your VIPCode: 3

MNote: The "Already Registered” and "Not Registered” values are estimates as a recipient can receive an email at one of the recsipient's email addresses and
use another email address when the recipient actually registers.

6|Page
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Campaign Stats

The list of email campaigns on Step 3 displays basic results in the grid. Stats include the number of new
attendees who registered (people who registered because of your campaign), attendees who were already
registered (people who registered before your campaign was sent) and those who have not registered.

Stat Definitions

New Registrants — Attendees who registered as a result of your email campaign

Already Registered — Attendees who received your email, but were already registered for the event
Not Registered — The number of recipients of your email who have not registered for the event
Sends — Emails successfully sent to recipients

Bounces — Emails that were rejected for any reason, e.g. not an email, email doesn’t exist, etc.
Clicks — A list of links in your email campaigns and the number of times each was clicked

A. Clicking the “Stats” text link for a

Campaigns:
campaign opens the reporting Product Name  Send Email Email  Hew Aready ot
interface in a new browser tab. Sm gl wesiede hzon e _ A 2
= R melam GEms Sed ’ =
B. The number of attendees who e Ee R AR s M " v
registered across all of your
campaigns is shown in the blue
Clicking the attendee number Nts: T *Already Regstarc and Not Regitered vals are stimates a8 3 rciiant cn raceva an amil a ona of the receipint’s smai addresses and

use another email address when the recipient actually registers.

opens a list of the registrants.

Stats — Summary

The Summary interface shows:

Bounces Clicks Preview

n The following stats are calcul in real-time except for the bounce stats, which are
. . . ca.lculated.twice a day. Typic it takes a leu.r days for th_e stats to settle, but the opens and
[} E ma || Su bJect ||ne clicks can increase for as lon he user retains the email.
L] Ca m paign Status Email Subject: Lead Retrieval and Attendee Lists
e Start and end dates and times Status: Done
. Start Date: Feb 2, 2011 1:38 PM
b Count Of unlque opens End Date: Feb 2, 2011 1:38 PM
e Count of unique clicks Email ID: 54615
Sent: 3
e Count of bounces e F s
Unigue Clicks: 1 — 33% of Sends
Bounces: 1 — 33% of Sends
7|Page
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Stats — Sends

The Sends interface shows:

e Recipient’s email address

e Times opened

Summary Sends Bounces Clicks Preview
Sends

Email Subject: Lead Retrieval and Attendee Lists

Status: Done

Start Date: Feb 2, 2011 1:38 PM

End Date: Feb 2, 2011 1:38 PM

H H Email ID: 54615
e Date of first opening ml
e Date of last opening sepats |
. Page:1 Results: 1 -3 of 3 Rows per Page: (20 [+
e Count of clicks
. . To Opens First Open LastOpen (Clicks First Click Last Click Sent On
b FIrSt ClICk date test3@formfields.com 2011-02-02
13:38:58
e Llastclick date e ——
13:38:58
o Campalgn Send date testS@goexposoftware.com 2 2011-02-07 2011-03-24 3 2011-02-02 2011-02-02 2011-02-02
15:48:17 22:35:46 13:40:24 13:42:48 13:38:59
Page: 1 Results: 1 -3 of 3 Go to Page:
Stats — Bounces summary | [sends | el | ciicks | | preview
Bounces

The Bounces interface shows:

Email Subject: Lead Retrieval and Attendee Lists

Status: Done

L4 Recipients email address Start Date: Feb 2, 2011 1:38 PM

e Bounce details or the returned error

End Date: Feb 2, 2011 1:28 PM

Email ID: 54615

message from the email account

Stats — Clicks

Bounces

Page: 1 Results: 1-10of1 Rows per Page: (20 [«

To Bounce Details

test3@formfields.com User unknown

Page: 1 Results: 1-10of 1 Go to Page:

Summary Sends Bounces Preview

The Clicks interface shows:

Email Subject: Lead Retrieval and Attendee Lists

Status: Done

e Thelink name, e.g. “Click here to Start Date: Feb 2, 2011 1:38 PM

register.”
e The link URL

e Count of times clicked
e Each links percentage of the total click

count

Download Stats

A link to download stats as and Excel file
appears at the bottom of each stats page.
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End Date: Feb 2, 2011 1:38 PM

Email ID: 54615

Page: 1 Results: 1-1of 1 Rows per Page: 20 ||
Link Name URL Clicks % of Total Clicks
Click here to register. https://www.xpressreg.net/register/nabs041/start.asp 3 100

Page: 1 Results: 1-10f 1 GotoPage:[

Download clicks 54615.xls

For technical support, please contact:
xpressleadpro@cdsreg.com or call 1-800-746-9734
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